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This tutorial supplements our classroom training material 
however due to the demand from remote customers unable 
to attend face-to-face training, we have made it freely 
available. 



I. FastCAM Installation 

 Selection of the correct NC controller is an important step in the 
software installation.  If uncertain, the correct controller can be verified 
on the cutting machine or by direct contact with the machine 
manufacture. 

Installation & Setup 



II. FastCAM System and Controller Settings are in the SETUP.DAT file and 

Control file these are normally located C:\program files\fastcam\ 
Occasionally these files may need to be edited for specific machines. If 
in Doubt contact your supplier or FastCAM Service. 

   Note: NC output files do not always end in [filename].CNC 

Other popular extension names are TXT and NC and some have no extension. 

Installation and Setup 



Installation & Setup Up 

III. Controller Setting (*.con file, * stands for the controller type, e.g. Edge.con) 



FastCAM System 
Overview 

I. FastCAM Application 
   Process 
 

 
Draw -> Nest -> Cut 
All in One program. 
 
We discuss, illustrate and 
demonstrate each 
function. 

Import CAD files from 
AutoCAD and other 
CAD products 

or 
Create part drawings 
with FastCAM Editor 
with CAM/DXF/DWG 
output 
 
Optimize cutting 
paths and process 
parameters 
 
Optimize material 
usage with mixed 
nesting, common 
edge cutting and 
remnant nesting 
 
Check and cost parts 
before cutting 
 
 
Optimized NC code for 
quality cutting 



Module 1   The Part Drawing - 45 minutes 
Lesson 1: FastCAM Drawing Editor Quick Study  (10 minutes)  
Lesson 2: FastCAM Drawing Editor Full Study       (30 minutes) 
Lesson 3: Working with CAD files                        (30 minutes) 
 

Module 2   NC Path Setting - 45 minutes 
Lesson 3: Manual Path Setting     (15 minutes) 
Lesson 4: FastPATH Automatic Path Setting  (30 minutes) 
 

Module 3   Part Nesting - 45 minutes 
Lesson 5: Manual Part Nesting     (15 minutes) 
Lesson 6: Automatic Mixed Part Nesting    (30 minutes) 
 

Module 4   Optimized Cutting– 45 minutes 
Lesson 7: Automatic Common Cutting    (15 minutes) 
Lesson 8: Bridges for Plasma Cutting   (15 minutes) 
Lesson 9: Automatic Continuous Cutting  (15 minutes) 
Lesson 10: Nesting exercises 
 

Module 5   FastCAM Solutions 
 
Appendix:  Technical Notes 

- END - 
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FastCAM Drawing Editor 

  - Quick Study 

 

FASTCAM Drawing Editor 

          - Full (self) Study 

 

Fundamentals: 
 

Point, Line and Arc 

Erase, Trim, Blocks, View, Utility and Text 

Text, Verify and Standard Parts 



Exercise 1. – Drawing Shape: 

1.1: Quick Study A:  Draw a Basic Shape 



Exercise 2. 

Drawing Shape: 

1.1: Quick Study B.  –  Draw a ‘Widget’ 



Other we suggest you try: 

1.1: Other Fast Study Examples: 



WIDGET 
Here you will go through the process of drawing a part in FastCAM® based upon a scaled part 
drawing.  For example you might receive a drawing from a customer like the one below: 
 

1.2.  FastCAM Drawing Editor – Full (Self) Study 



With any drawing you do in FastCAM®, the first step is to identify the individual shapes 
within your part.  This may take some time at first, but with practice and experience, you 
will learn how to quickly evaluate and determine what entities are necessary to create a 
part. 
 
In our WIDGET, it is important to notice there is a rectangle on the left side within the part.  
This rectangle also has two smaller internal circles.  On the right side, you can see a 2-circle 
ring.  The rectangle and ring appear to be blended together with two lines. 

Rectangle  Connecting Tangent Lines  Ring  



Once you have identified the different entities in the part, we start by running the 
FastCAM® drawing editor.  Upon opening FastCAM®, you should see the screen below.  



To create drawings to scale, it is easiest to use absolute coordinates.  Absolute 
coordinates are based upon the Cartesian coordinate system as shown below.  



If you are unfamiliar with the Cartesian coordinate system, it is a good idea to 
review or practice using this principle.  In FastCAM®, you can choose to display 
the x and y axis to assist you in drawing your parts.  Click on the View menu and 
select Change Display.  From here, check the box for Axes and then press ENTER. 



You can start by drawing the rectangle.  It is best to do this using the Box feature. 
From the Line menu select Box.  

By default, FastCAM® is set to draw a box using screen positions.  This function allows you 
to quickly draw rectangles by simply clicking on the screen but does not allow for parts to 
be drawn to scale.  To draw your part to scale, you must switch to the absolute coordinates 
by right clicking once on your drawing space and selecting Absolute Coordinates.  



You can now enter the x,y coordinates for two opposite corners of you rectangle.  Based 
upon your drawing, you can enter two diagonally opposite corners of your box.  You can use 
a first point of (0,0), a second point of (0.5,2) and click ‘Enter’. 



Many of the drawing functions in FastCAM® are repetitive. To get out of any command 
or popup window, you will need to right-click until the menu bar is back to active.  



The rectangle should now be drawn to scale and appear on the screen as shown below. 
When drawing items, FastCAM® often automatically prompts for a second item to be 
drawn.  If this is not desired, you may simply hit cancel and right click on the screen 
repeatedly to get out of any popup windows. 

The next step would be to create the other side of our drawing (the rings.)  You could 
draw two full circles with the same center, but it is easier to use the Ring feature under 
the Arc menu. 



FastCAM® will prompt you for an inside diameter and an outside diameter of the two 
circles that make up the ring.  Here you can key in .429 for the ID, 1.26 for the OD and 
click ‘Enter’. 

Next, you will be prompted to select the center point for your ring.  Again, you can use 
absolute coordinates, key in (1.252,1) and click ‘Enter’. 



You should now see a full ring just to the right side of your previously drawn rectangle.  
If at anytime you need to refresh your screen (if the image of your drawing is not 
clear), hit the Enter key once. 

Finally, you need to draw lines to connect the rectangle to the ring.  There are many choices 
for drawing a line however, you can see from the scaled drawing that you need to use tangent 
lines.  Therefore, you need to select the Tan to circle option under the Line menu. 
 
You will first need to select the arc (circle) in order to start the line.  To do this you must click 
on the outer circle on the nearest side to where the line will intersect. 



Note : Horizontal infinite line will be created by left-click of mouse cursor at the 
approximate 6 and 12 O’clock positions. Likewise, vertical infinite line will be drawn 
by left-click of mouse cursor at the approximate 3 and 9 O’clock positions. 

FastCAM® will then prompt you to choose an angle or a given point as an endpoint of 
your line.  In this situation, you will want to select Given point and then click on the 
upper right-hand corner of the rectangle.  After selecting Given point, the program will 
automatically switch to Control Points (from Absolute Coordinates) as can be seen by 
the prompt message on the screen.  This means that as long as you click near the point, 
the line will “snap” exactly to this point.  These points are called control points and you 
can see them in green and red below.  



Repeat these steps for the other connecting line and you should then have the same as 
the drawing below. Be sure that you clicked at the appropriate point on your entity and 
that the correct tangent line appears. 

Our part is now drawn except for a couple of internal circles.  First, you can zoom into this 
part by choosing Autoscale under the View menu, or by hitting the number 5 on the 
numerical keypad of your computer. 



To draw a circle, go back up to the arc menu and select Full circle. 

FastCAM® will ask for the radius of the circle.  Since we have the diameter, we can 
simply enter the diameter followed by the letter “d” as shown below and click ’Enter’. 



We can then enter the absolute coordinates of the lower internal circle based upon our 
scaled drawing.  After you enter the diameter, you may have to right click and select 
absolute coordinates. 

Many drawing functions in FastCAM® are repetitive, and the Circle function is one of 
them. Once we have drawn the first FastCAM® prompts us for another set of Absolute 
Coordinates for the next circle location. In this example it is easiest to use Incremental 
Coordinates, based on the drawing supplied.  To do this, right click once and choose to 
use incremental coordinates. 



FastCAM® will ask if you want to use your previous point as your new reference point.  
Select yes, and enter coordinates based on that the point selected is now your 
reference of (0,0). 

Now we need only the distance between the two circles, or the change in y value. 



We now have a completed drawing, but need to erase some internal lines and arcs that 
are not  in our final drawing.  To erase a line which makes up part of the rectangle, go up 
to the Erase menu and choose Line.  

Left click on the line you wish to erase once, and then right click on your drawing to 
fully erase this entity. 



Now we can eliminate the last internal arc that is not part of the final drawing.  Go 
under the trim menu, and select Smart Trim. 

Select the section of the circle that you wish to trim by clicking on the left side of the 
large circle of the ring that you want to trim.  The unwanted arc should be removed. 



Now return to the View menu and uncheck the display axes box to remove them from 
your drawing.  You will then see your completed WIDGET drawing. 



Finally, there are a number of ways to verify the scale of your drawing.  The quickest 
way is to go under the View menu, choose Change display, and check the box next to 
Auto Dimension.  Then click okay to view the dimensions of your part drawing.  

We can see our part meets the dimensions of our scaled part drawing.  We can be 
confident that we have created a part with FastCAM® that is identical to our scaled 
drawing. 



Module 1  Lesson 3 
 

Working with CAD files 
               

(30 minutes) 



The following CAD features are integrated into the 
FastCAM Drawing Editor. 

 

Main functions:  

(1) Clean imported CAD files for quality cutting. 

(2) Compress CAD files to improve cutting speed. 

       

 Covers: DXF/DWG restore, explode, CAD layers, 
text marking, dimensions, verify, simple/overcut 
bridge, fillet corners … etc.  

3.1   CAD Optimization 



I. Purpose for CAD Clean  

 

Lesson 3   CAD Optimization 



II. CAD Clean result 
 

Lesson 3   CAD Optimization 



III. Purpose for CAD Compress 
 

Lesson 3   CAD Optimization 



IV. CAD Compress 
 

Lesson 3   CAD Optimization 



Utilities:  Round Corners  
When dealing with small detail on parts quality can be sometimes be 

improved by rounding sharp corners, typically the rounding value should be 

the same size as ½ the kerf width IE if the Kerf is 3mm round all corners 

should be rounded to 1.5mm     



 Fix Joints 
Small gaps in parts can be automatically repaired using the Fix Joints feature. Select the gap size and apply to a 

single gap or across the entire drawing   NB you can also Sharpen Corners if required. 



Exercise - CAD Clean/Compress for DXF/DWG 

Exercise. 3 

i. Compress number of entities in exercise ‘1.CAM’ 
from 9871 down to 518 and note there should 
be no change to its shape. 

ii. Create your company name with a graphics 
program such as CorelDRAW and save as DXF 
format. Compress number of entities to 
minimum without change of shape in FastCAM 
for normal cutting. 

Exercise. 4 

Check exercise ‘2.CAM’ and find the reasons why 
this part has more than 18 entities. 

Lesson 3   CAD Optimization 



5 min. break 



Module 2  NC Tool Path Programming 
               

(45 minutes) 

 

Lesson 3: Manual Path Programming         (15 minutes) 

 

Lesson 4: FastPATH Auto Path Programming (30 minutes) 



Lesson 3   Manual Tool Path Programming 



Lesson 3   Manual Tool Path Programming 



I. FastPATH 
 

This program is not shown individually on the desktop. 

You can apply settings in FastCAM or FastNEST. 
 

This program allows you to fully automate the setting of 
cut paths for optimum operation efficiency with: 

Automatic setting of entries and exits. 

Set kerf compensation. 

You can also set various cutting techniques including 
common edge, bridging and common cutting. 

Lesson 4   Automatic Path Programming 



 1. Cutting process 

 

Lesson 4   Automatic Path Programming 



2. External entry 

Lesson 4   Automatic Path Programming 



3. Internal entry 

Lesson 4   Automatic Path Programming 



 4. Cut Sequence 
 

Lesson 4   Automatic Path Programming 



5. Special Setting 

Lesson 4   Automatic Path Programming 



6. Stitch / Kerf Compensation 

 

Lesson 4   Automatic Path Programming 



 7. Nest Options 
 

Lesson 4   Automatic Path Programming 



8. Router / Bridges 

 

Lesson 4   Automatic Path Programming 



II. FastCAM automatic path programming 

1. FastCAM manual output of NC codes (single part) 
 

Lesson 4   Automatic Path Programming 



2. FastCAM manual output of NC codes (nested parts) 

Lesson 4   Automatic Path Programming 



3. FastPLOT Verification 
 

Main functions: 
 

1) Cutting path verification 

 Simulate the NC file, step-by-step trace on and cut 
dimensions. 

2) Cost audits 

 Audit cost of material and cutting according to the 
programmed result. 

3) NC file and codes interchange 

 Convert NC codes back to part drawing or change 
between NC codes. 

Lesson 4   Automatic Path Programming 



1) Cutting paths verification 

Lesson 4   Automatic Path Programming 



2) Cost audits 
 

Lesson 4   Automatic Path Programming 



 Manual Path Programming Exercises 

     Exercise 5. Use the manual path method, generate NC outputs for exercise “1.CAM”  
     after the CAD optimization and study the result. 

 Exercise 6. Use the manual path method, generate NC outputs for exercise “2.DXF”  
      after the CAD optimization and study the result. 

 Requires: set process for cutting, entry with straight line at 8 mm length, angle 
equals zero and no exit. Also try the half/quarter circle and 90 degree angle for entry 
to observe the difference in results. 

 

 Automatic Path Programming Exercises 

 Exercise 7. Use the automatic path method, generate NC output for part “1.DXF” 
after the CAD optimization and study the result. 

 Set: Straight line for external entry and exit with length of 8 and 6 mm, quarter 
circle for internal entry and exit with 6 mm radius, 10.1 mm for center pierce hole, 
no overcut, no compensation and follow the default values for the rest.  

 Exercise 8. Use the automatic path method, generate NC output for part “2.DXF” 
after the CAD optimization. Verify NC outputs in FastPLOT, check any change in 
dimensions and explain any difference. 

 Set: Straight line for external entry and exit with length of 10 and 6 mm, quarter 
circle for internal entry and exit with 8 mm radius, no overcut, compensation at 1.8 
mm, nest plate for nest options and follow the default values for the rest. 

Lesson 4   Automatic Path Programming 



5 min. break 



Module 3  Automatic Nesting 
               

(45 minutes) 

Lesson 5: Manual Nesting          
    (15 minutes) 
 
Lesson 6: Automatic Mixed Nesting  
    (30 minutes) 



I. FastNEST Nesting Module, desktop icon    

 

Main functions: 

1) Full Plate and Remnant Nesting - 

 Implement automatic cutting to improve material 
utilization and nesting for remnants to save material. 

2) Nesting Methods –  

 Manual, Array, Automatic and Mixed Types. 

3) High Efficiency Cutting - 

 Common Edge, Bridging, Common Cutting. 

Lesson 5   Manual Nesting 



II. Manual Nesting 
      1. Set parameters: Input/Output file type, FastNEST parameters, 

Interactive nesting menu. 

 

Lesson 5   Manual Nesting 



II. Manual Nesting 

 1. Set parameters: Plate list, Save Nest and Retrieve Nest 
       

Lesson 5   Manual Nesting 



II. Manual Nesting 

Lesson 5  Manual Nesting 



II. Manual Nesting 

Lesson 5  Manual Nesting 



I. Automatic Nesting 

Lesson 6  Automatic Mixed Nesting 



II. Automatic Mixed Nesting 

Lesson 6  Automatic Mixed Nesting 



 Manual Nesting Exercises 

 Exercise 9: Apply manual nesting followed by NC output for part 
‘4.CAM’ and study the result.  

 - Requirement to set the automatic FastPATH technique 

 Exercise 10: Apply manual nesting followed by NC output for part 
‘3.DXF’, note the cutting sequence/changes in FastPLOT and check 
costing data for job record. 

 - Requires to set the automatic FastPATH technique 
 

 Automatic Mixed Nesting Exercises 

 Exercise 11: Apply automatic mixed nesting followed by NC 
output for part ‘6.DXF’ and study the result.  

 - Requires to set the automatic FastPATH technique 

 Exercise 12: Apply automatic mixed nesting followed by NC 
output for part ‘5.DXF’, observe cutting sequence/changes in 
FastPLOT. Check costing data and compare with the result from 
Ex. 2 of manual nesting to understand the benefits from 
automatic mixed nesting … 

 - Requires to set the automatic FastPATH technique (must be with  
same setting as Ex. 2 of the manual nesting) 

Lesson 6  Automatic Mixed Nesting 



5 min. break 



Lesson 7: Automatic Common Cutting (15 minutes) 
 
Lesson 8: Plasma Bridging        (15 minutes) 
 
Lesson 9: Automatic Continuous Cutting  
  (15 minutes) 
 
Lesson 10: Nesting exercises       (15 minutes) 

Module 4   Optimized Cutting  
(45 minutes) 



I. Automatic common edge cutting 
 

Lesson 7  Automatic Common Cutting 



Common Cut Pairs 

Common cut pairs are defined by joining two 
identical parts along a common straight 
boundary. This can reduce the cutting and 
halve the piercing. It is used most often in 
shipbuilding as it is common to encounter 
left and right hand pairs.  

 



II. Mixed Automatic Common Edge Cutting 

Lesson 7  Automatic Common Cutting 



II. Mixed Automatic Common Edge Cutting 

Lesson 7  Automatic Common Cutting 



I. FastCAM Bridges 
 

Lesson 8  Bridges for Plasma Cutting 



Bridging Information Update for v5.10 

FOUR different types that will be included in the Professional Edition. Bridging can be 
combined with other processes such as line marking and text marking.  

 1) (Traditional) Bridging. A simple positive bridge is where parts are connected 
together linked by two parallel cuts (bridge). Bridges allow continuous cutting and are 
traditional in many shipbuilding applications. The result is much faster cutting. Parts are 
left joined, but this can be an advantage in some circumstances. These include making 
assemblies, moving the parts as a group and minimizing part movement (appropriate 
for lighter materials or thinner materials).  

 2) Overcut or Negative Bridging allows for continuous cutting with the immediate 
separation of parts. This is a FastCAM® invention that has the advantages of bridging 
but cuts out the bridge on the return. Previously available in the FastCAM® drawing 
editor, this function is now available in FastNEST® where it is perhaps more intuitive. 
Selecting this function will deliver a speed increase on many nests and result in a 
reduction in piercing making it a feature of interest to a wider range of customers.  

 3) Skip Bridging. Here you have additional piercing and the parts are held together by 
a bridge but the bridge is not cut. This can be used for routing aluminum, as it prevents 
vibration but does involve piercing on the edge, which is fine for routing. You actually do 
much more piercing and save nothing on cutting, so it is a device mainly to prevent 
vibration and movement. A simple gap bridge forms much the same function for lighter 
materials where the resultant tabs can be broken manually. In this case, additional 
pierces are required rather than fewer. (This function is aimed at aluminium routers but 
can be used in any instance where the programmer does not want the bridge to be cut).  

 4) Skip with Entries. As with Skip Bridging, but pierces are away from the part edge.  

 



II. FastNEST Bridges 
 

Lesson 8  Bridges for Plasma Cutting 



Lesson 9  Automatic Continuous Cutting 



Common Cut Information Update 

In FastCAM® Professional 
v5.10, we have 
introduced the ability 
to completely 
common cut nest. 
Compared with 
traditional nesting of 
separate parts each with 
their own external entry 
and exit, FastCAM® 
Common Cut Nest gives 
you the ability to set the 
part spacing to exactly 
the cut width before 
nesting. See next slide. 



Compared with traditional nesting of separate parts each with their own external 

entry and exit, FastCAM® Common Cut Nest gives you the ability to set the 

part spacing to exactly the cut width before nesting.  

 

FastCAM® v5.10 achieves 'zero gap' common cutting by cutting entire nests 

using a start on (part) edge approach. In many nests this will usually eliminate 

piercing time and halve cutting time. Intelligent strong/weak analysis logic is 

built into the software to minimize part movement however there is the 

potential for slightly damaged parts so part quality is a consideration. There is 

also the potential of damage to the part if an edge start command is not 

present in the NC control. However it offers the possibility of many common 

cuts in a nest of largely rectilinear parts where quality is not the main concern. 

It is dramatically faster with far less piercing. For rectilinear parts such as 

nests of rectangles, the saving in piercing can be 5x. The saving in cutting can 

be 2x, yielding gains of 10x in total processing speed!  

Like any new technology, there are advantages and disadvantages depending on 

the application. The NC programmer can quickly weigh up the pro's and con's 

on a job by job basis. Certainly if you're cutting barbeque plates or similar 

then the efficiencies using the new Common Cut Nest feature can be 

remarkable.  

 



Exercise 13. With common cutting, prepare nesting for part ‘6.DXF’ and 
‘7.DXF’ then generate the NC outputs. Using the same parameters, 
check in FastPLOT and record the costing data. 

 Requirement : Kerf 2 mm, Plate size 6,000 mm and 4,000 mm, Part 
quantity 30 and 18. 

Exercise 14. With mixed common cutting, prepare nesting for part 
‘6.DXF’ and ‘7.DXF’ then generate the NC outputs. Using the same 
parameters, check costing data in FastPLOT and compare result from 
Ex. 1. 

 Requirement : Kerf 2 mm, Plate size 6,000 mm and 4,000 mm, Part 
quantity 30 and 18. 

Exercise 15. With bridge cutting turned on in FastNEST, prepare nesting 
for part ‘6.DXF’ and ‘7.DXF’ then generate the NC outputs. Using the 
same parameters, check costing data in FastPLOT and compare 
result from Ex. 1. 

 Requirement : Kerf 2 mm, Plate size 6,000 mm and 4,000 mm, Part 
quantity 30 and 18. 

Lesson 10   Nesting Exercises 



5 min. break 



Changes in FastCAM ®  7 

V7.1.048 

New Features: 
General: 
System migrated to 64-bit processing, speed, and various system limits such as entities and parts have been 
significantly increased. 
File saving for Multiple Plates previously adds a space to the nest named appended by the plate number. The 
space can now be adjusted to another character. 
More specifically…. 
FastCAM® 
64-bit processing now supports up to 500,000 entities, up from 32,000, tools such as Cad Compress will show 
significantly speed increased. 
Added Move Entry accessible via a new button on the toolbar. This is the move entry module found in FastNEST.  
Adding the flexibility this module has provided for Nest programming to Single Part Programming. 
Ring Feature has been renamed to Flange 
DSTV importing will now provide Additional Information to show why certain DSTV files are deemed 
inappropriate. 
Stored view increased from 10 to 50 
Offset Contours now provides options to retain Sharp corners or convert to Round corners – from Round Corners 
only 
 



Changes in FastCAM ®  7. 

New users or moving from FastCAM ®  V5.10 and earlier 

FastCAM®  v7.1.113 Update Information 
†In order to apply the update from version 5 and older, please ensure you have obtained additional dongle activation 
codes. 
 Please supply your Dongle’s License number to fastcam@fastcamusa.com or fastcam@fastcam.com.au to obtain the 
activation to run FastCAM7 on your existing dongles. 
To obtain your License number:- 
Run FastCAM 

Choose CONTROL POINTS – LICENCE from the menu. The number after the #is your serial number. 
†A backup of your FastCAM5 will be created in the folder 

 C:\Program Files\FastCAM\FCLastVersion 

New Features: 

General: 
DWG Restore is now compatible with AutoCAD Dwg2010 file formats. 

Revisions: 
Service Email module updated to correct the listing for new dongles with their longer license number. 
Language files updated 

Fix to FastPLOT display of rapids, it was previously displayed as solids lines instead of rapid lines for some Controls. 
Fix to a case where bridges on arcs also had entry and exits added.  
Fix to an error when adding bridges between ellipses 

Fix to a pass of CAD Clean in FastNEST to better handle small kerf. 
  
  
  

mailto:fastcam@fastcamusa.com
mailto:fastcam@fastcam.com.au


Module 5  FastCAM Solutions 
 

               

FastCAM software isn't limited to drawing and 
nesting! One of the benefits of having the largest 
range of software for steel fabrication means that 
over the years, we've solved many unique and 
complex fabrication problems. Our software is 
often a central aspect of the total engineering 
solution.  
 

We highlight a few popular programs that can be 
used in conjunction with FastCAM or purchased as 
stand alone programs. 

 



 
Automate fabrication/weld calculation and layout of 

multi segment heavy plate transitions, boilers, 

blowpipe, power, transitions. Huge saving of skilled 

manpower required to calculate unfolding and fitup.  

I. FastSHAPES® Heavy Plate Development 



The Fast Way to Profile Pipe Ends for 
Pipe to Pipe & Reticulation  

II. FastPIPE™ 

FastPIPE simplifies & speeds All Types of 
Pipe Development & Estimation work  

 Produces Wrap around templates with 
full Weld Preparation details 

  



Saves hundreds of hours in the design stage of complex space frame 
developments. Complete structural frames can be completed in days!      

Of equal value, the extraction of fabrication data needed for processing is 
simple!  

III.  FastFRAME® Complex Tubular Space Frames 



For Burning, Shearing, Sawing, Drilling  

IV.FastCAM® QE™ 
Optimized Estimates for Processed Steel 

Comprehensive, Purpose Built 
Quotation System for Metal 
Service Centers.    

 
Contains both Linear and Plate 

based optimization with the 
least percentage scrap.  

Produces an Email or fax ready quote after nesting, with full 
allowance for all remnant, scrap and processing costs. 

 
Profiling, Shearing: Parametric, True Shape, Rectangular 
Sawing, Drilling for Long products, Beams, Channels, Angles etc. 

http://www.fastcamusa.com/new/quoter/


V.  FastCOPY® for Parts & Drawings  

Offline system for fast, 
accurate conversion of 
existing parts, templates, 
or drawings into DXF & NC 
code ready for ‘best 
quality’ cutting.  Easier 
than an electronic eye.  
Includes a new design 
lightweight portable ‘plug 
and play’ digitizer for ease 
of use and storage.   Packs 
away in minutes. 

Adds value to any busy service center 
or business needing to copy and 
profile cut complex parts or 
precision artwork from metal. 
Destroy/archive old paper drawings 
and instantly retrieve templates.   
Easy to use. 

http://www.fastcamusa.com/new/posts


 Optimized layouts for general cutting of 

lengths or rectangles, shears and saws (plate & 

bar).  Nests then prints graphic cutting lists.  DXF 

output.  Use for basic costing information. 

VI.  FastCUT® Optimizer  

Saves material and 
operator time.   
Improves time to 
quote.  Reduces 
cutting errors and 
layout time. 

http://www.fastcamusa.com/new/fastcutmetal/


Minimizes stock holding of partially processed plates and uses the most cost 
effective plate stock for the job. Fast stock take & auditing system.   

VI.  FastTRACK® Plate Tracking  



VII.  FastCAM Bevel for Weld Ready Parts 

Ultra simple automatic 3-Pass beveling to achieve weld ready parts (true K,Y 
engineering parts for heavy plate forming).  



Some features that you can add to your FastCAM® System 

include:    

 

 
  Text marker is useful plate marking software for NC machines fitted with Scribes, 

Punch Markers, Plasma Etch markers & Ink-Jet.  Converts text & numbers into 
stroke font movements. Uses stroked characters for minimal machine movement. 
Ideal for lasers and/or plasma with low power torches.  Requires FastCAM®. 
 

  FontGEN converts ‘Windows’ fonts into a format for NC cutting. Ideal for cutting all 
styles of letters and fonts such as used for signwriting etc. 
 

  Outline converts pictures or shapes ready for cutting. Ideal for converting non-
dimensioned artwork into cutting files. Ornamental iron work, signs, machinery 
logos etc.  Reads most graphic formats. 
 

 NC Collision Checker replaces the visual checks in both FastNEST and FastPLOT to 
be computer based and automatic.  Of value in big and complex nests where a 
small overlap can easily be missed resulting in expensive cutting mistakes. 
 

 FastLINK provides a fast DNC file download link from older controllers which speeds 
up processing. 
 

 



Did you know that FastCAM® Profiling Systems 
support multiple posts?  

 
If you replace or add another type of cutting machine you 

don't need to change your programming system!   
 
If you are on an Annual Service Agreement, we will support 

you getting your machines up and running! If you are 
not on a Service Contract we will provide technical 
support at current rates. We invite you to call us to 
discuss machine specific details.  

 
Note: Excludes FastCAM® Systems marked as 'OEM' 

versions (Specific machine bundled software).  
 



 

FastCAM programs that use a physical hardware security lock or 
dongle are:  
 

 FastCAM   FastPLOT   FastNEST  FastSHAPES  FastTRACK   
FastCOPY   FastLINK  

 

 What happens if you make changes to your PC and you use one 
of these 'dongles'?  

 Changes to your network card or any other internal hardware, 
upgrading your operating system etc. should make no difference. If 
you buy a complete new PC then just make sure that you remove the 
dongle from the old PC and attach it to the new one.  

 If you require a USB dongle you only need to purchase a new holder 
(outer case) from us. We will also send a simple instruction sheet on 
how to transfer your unique ID 'button' from one holder to another.  

 Later versions of the software have the new “Unikey” dongle, if this is 
damaged we can replace it for a small charge. You will however be 
required to return the old key to us.   

 If your dongle is lost or stolen you may need to purchase a new 
software system. Please contact FastCAM     
 



Today FastCAM has many more products encompassing many 
industries and distribution points and FastCAM is used in many 
different environments around the world. 

   
 

• STEEL SERVICE CENTERS  
• STEEL FABRICATION  
• METAL FABRICATION  
• MINING  
• CONSTRUCTION  
• SIGNCUTTING  
• WOODWORKING  
• FLAT GLASS  
• EDUCATION  

Conclusion 



Please visit www.fastcam.com  

for more information. 

End of Tutorial 

Thank You! 

http://www.fastcam.com/

